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Preface

HP OpenView Service Quality Manager SLA Administration User Interface is part
of the Hewlett Packard solution for Service Quality Management. This manual
describes the Graphical User Interface (GUI) and explains how to use the SLA
Administration User Interface in the context of the HP OpenView Service Quality
Manager complete solution.

Intended Audience

This document is intended for personnel who will use the HP Service Quality
Manager SLA Administration User Interface.

HP OpenView Service Quality Manager
Documentation Set

The following documents form the set of HP OpenView Service Quality Manager
User Guides:

e OpenView Service Quality Manager Overview.
e OpenView Service Quality Manager SLA Monitoring Ul User’s Guide.

e OpenView Service Quality Manager Administration Ul User’s Guide (this
manual).

e OpenView Service Quality Manager Ul User’s Guide.

e OpenView Service Quality Manager Service Designer Ul User’s Guide.
e OpenView Service Quality Manager Planning Guide.

e OpenView Service Quality Manager Installation Guide.

e OpenView Service Quality Manager Administration Guide.

e OpenView Connectivity Installation and User’s Guide.

Prerequisites

To be able to use HP OpenView Service Quality Manager SLA Administration Ul,
the core components must be installed and started. Refer to the HP OpenView Service
Quality Manager Installation Guide.

It is recommended that Users have knowledge of the platform and of the Service
Model.




Software Versions

The software versions referred to in this document are:

Service Quality Windows

Manager

1.2 Windows XP
Support

Please visit our HP OpenView web site at:

http://openview.hp.com/

There, some contact information is available as well as details about the products,
services, and support that HP OpenView has to offer.

The HP OpenView support area of the HP OpenView web site includes:
¢ Downloadable documentation

e Troubleshooting information

e Patches and updates

e Problem reporting

e Training information

e Support program information.



http://openview.hp.com/

Chapter 1

Introduction

This chapter introduces the HP OpenView Service Quality Manager
SLA Administration User Interface, and places it in the context of HP OpenView
Service Quality Manager.

1.1 What is HP OpenView Service Quality
Manager?

OpenView SQM provides a complete service quality management solution. It
consolidates quality indicators across all domains — telecom, IT networks, servers,
and applications — giving end-to-end visibility on service quality. OpenView SQM
links service quality degradations to potential affects on business, allowing the user to
proactively address problems and prioritize actions.

OpenView SQM monitors the service quality by aggregating information coming
from all of your data sources, such as the network, the IT infrastructure, and your
business processes. Using this information, the user can pinpoint infrastructure
problems and identify their potential affect on customers, services, and SLAS.

1.2 What is a Service Level Agreement?

An SLA is a contract that specifies, among other things, service quality criteria and
values against these criteria that must be achieved by the service provider to satisfy
the customer. The criteria are often related to the quality of service and are expressed
through service levels and thresholds.

This section describes the role of SLAs and service levels, and introduces the SLA
lifecycle.

1.2.1 Role of SLAS

OpenView SQM supports two types of service level agreements:
e Customer SLAs.

A customer SLA is a set of service quality parameters with threshold values that
characterize the service quality to be achieved for a service sold to a customer.

e Operational SLAs.

An operational SLA is a set of service quality parameters with threshold values
that characterize the service quality to be achieved by a department within the
service provider’s organization.

These SLAs are not related to any customer in particular and allow the user to:




Test future customer SLAs by checking whether future service quality
proposals can be achieve.

Prioritize work within the organization.
Improve the performance of internal processes.

Manage the relationship between the different departments.

1.2.2 About Service Levels

A service level describes the objectives to be achieved by the service provider for a
given service. A service level gives a set of service quality parameters required for
controlling the quality of service along with their threshold values.

When selling a service to a customer, the service provider often has various
marketing offers for the same service, such as a “gold”, a “silver”, and a “bronze”
quality of service offer. Each of these offers corresponds to a quality of service, a
price, and a specific service level.

The service quality parameters are usually specific to the service and should be
expressed in terms that the customer understands.

The difference between the “gold”, “silver”, and “bronze” service levels depends on
the threshold values, which fix the agreed level of quality of service to be delivered.
For example, the “gold” quality of service would have a higher bandwidth offered
than the “silver” and “bronze” offers.

1.2.3 About the SLA Lifecycle

The SLA lifecycle describes the interactions between the various processes involved
in service quality management. It has the following five phases:

e Service design phase

In the service design phase, the user identifies the parameters used to evaluate
service quality and use them to build the service model for service quality
management.

The result of this phase is a unique service class broken down into service
components that provide the relevant service quality parameters.

e Service instantiation phase

Before the service instantiation phase, a negotiation and sales phase occurs that
lead to an SLA contract signature for a particular service. Negotiation and sales is
outside the scope of the SLA lifecycle.

In the service instantiation phase, a new service needs to have its quality
monitored. For example, a service model needs to be instantiated when a customer
buys a new service. Service quality management begins as soon as the service is
launched.

This phase results in a service instance and triggers the collection of service
quality parameters.

e SLA creation phase

In this phase, an SLA is created for a specific service instance or a group of
service instances, depending on the contract. All the threshold values of the
service level are identified for each service quality parameter managed for the
SLA.

10



This phase results in an SLA that:

Associates the service instance(s) with the service level and a customer (for
customer SLAS).

Associates the service instance(s) with the service level and an internal
department (for operational SLAS).

e Service monitoring phase

In this phase, the service and the service level agreement are monitored in real-
time.

The goal of the service monitoring phase is to rapidly handle any service
degradation to avoid SLA violations.

e Service reporting phase
In the service level reporting phase, reports about service quality are generated.

This phase assesses service quality on a long-term basis (monthly or quarterly) to
analyze service trends or to provide customer service quality reports.

Figure 1 illustrates the SLA lifecycle and shows the different OpenView Service
Quality User Interfaces that can be used during the different phases.

Figure 1 OpenView Service Quality Manager and the SLA Lifecycle
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1.3 What is SLA Administration UI?

HP OpenView Service Quality Manager SLA Administration Ul is the part of
OpenView Service Quality Manager that facilitates the tasks involved in the
administration of SLAs.

It is a Graphic User Interface that facilitates the Service Instantiation, the creation and
management of Service Level Agreements and the management of Services.

Its relationship to HP OpenView Service Quality Manager as a whole is illustrated in
About Service Levels.

HP OpenView Service Quality Manager SLA Administration Ul uses the
Definitions (including their attributes and parameters) defined in the Service Design
stage using Service Designer, and enables performing all the actions necessary to
manage and administer Services, Customer Service Level Agreements and Service
Levels.

The Service definitions created with Service Designer are saved and stored in the
SQM Repository. Using SLA Administration Ul, new Services can be instantiated
using these definitions.

In OpenView Service Quality Manager SLA Administration Ul, the generic term
Object is used for the items on which the actions can be performed. These Objects
are:

e Service

e Service Group

e Customer

e Operation

o Data Feeder

e SLA (Service Level Agreement)

e Service Level

12



All activities that can be performed using SLA Administration Ul are illustrated in
Figure 2.

Figure 2 SLA Administration Ul
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The SQM Repository is the storage center for all SLA Administration data. It
receives data from the various OpenView Service Quality Manager interfaces, and
each interface can request information data from the Repository.
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Chapter 2

Getting Started

This chapter describes how to start the Service Level Administration User
Interface, and how to get help.

2.1 Starting the SLA Administration Ul

An icon for HP OpenView Service Quality Manager SLA Administration Ul will be
placed on your Desktop when the application is installed.

To start the SLA Administration Ul, double-click on this icon E'Eb

The window illustrated in Figure 3 will open.

Figure 3 SLA Administration Ul First Window, Showing Window
Layout

14, hp OV SLA Administration UL E =10j |

File Edit Wiew Action Window Help

0-&-8 | s0@| x|+ BR| =

{5 consoe 0 x

@ Jan 12, 2004 3:09:48 PM - Application is started
@ WJan 12, 2004 3:09:53 PM - Application onling ahd connected to the server

| &

While the application is connecting to the server, the red (@ offline icon is displayed
in the information bar at the bottom of the window.

When the connection is successful, a message indicating this is displayed in the
bottom information bar of the window, and the Green Online icon E& replaces the
Offline icon in the information bar.
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The Console (icon ), displayed at the bottom of the window, just above the status

bar, displays messages relating to the performance/status of the application. See
Figure 3.

If the application doesn’t connect to the server, refer to Chapter 7, the troubleshooting

section of this manual.

Important

When the application is connected to the server, the connection with the SQM
Repository is made automatically.

2.2 SLA Administration Menu Bar

The standard menu bar gives the following options:

File

(- i ST VT

]

[» O M

Connect

Disconnect

New:

Open...
Close
Save
Save All
Duplicate
Delete
Refresh

Import

Export

Exit

Cut
Copy

Paste

Console

Search Panel

Allows the user to connect to the SQM Repository.
(This is grayed if the application is connected.)

Allows the user to Disconnect from SQM
Repository.
(This is grayed if the application is not connected.)

Displays a sub-menu of the Objects that can be
created (Ctrl/N)

Opens an Object (Ctrl/O)

Closes the current Editor (Ctrl/F4)

Saves the Object in the current Editor (Ctrl/S)
Saves all Objects in open Editors

Duplicates the object in the current Editor
Deletes the Object in the current Editor (Ctrl/D)
Refreshes the Object in the current Editor (F5)

Displays a sub-menu of the Objects that can be
imported from XML files.

Displays the dialog box allowing the user to export
Obijects to XML files.

Exits the application

(Ctrl/X)
(Ctrl/C)
(CtriIV)

Displays or closes the Console

Displays a sub-menu of the groups of Objects for
which the user can perform a search

Displays or Closes the Search Panel

16



e Action

= Resume
(Green
Triangle)

] Suspend
(Red
Square)

e Help
Content
About

e  Window
Cascade
Tile
Horizontally
Tile
Vertically

Arrange
Icons

Resumes Data Collection

Not available for all Objects

Suspends Data Collection

Not available for all Objects

Displays this User Manual

Displays information about the application

Changes the window display to cascade

Displays the open windows horizontally as tiles

Displays the open windows vertically as tiles

When several objects are opened and iconized in the SLA
Administration User Interface window, this action allows
the user to re-arrange them in the window as he wants.

2.3 SLA Administration Toolbar

The most common actions available on the Menu bar are also available as shortcuts

on the Toolbar.

DEsEHE | % LB B - =

2.3.1 Contextual Menus

If a right-click is performed on some items, contextual menus are displayed.

2.4 How to Get Help?

The SLA Administration Console displays messages that provide information about
the actions previously performed.

Messages are also displayed on the bottom bar of the screen and an action progress
gauge is displayed on the right of this bar.

Messages and tips are displayed on the appropriate screen relating to the actions the
user is about to perform, or have just performed.

There is no Context-Sensitive Help provided with this version of SLA Administration

Ul.

The Help menu provides two options:

e Content

displays this manual on-line.

e About

displays details of the application version and Copyright information.

17



2.5 SLA Administration Ul Object Editors

The Object editors provide the means of performing all the actions required to use the
SLA Administration Ul. These graphical interface editors provide two modes of
working, Create Mode, and Edit Mode. The mode is indicated in the editor window
title.

Important

An asterisk is displayed to the right of the word Mode when a change has been made
to a detail or Object that has not been saved in the SQM Repository. When the Object
has been saved, the asterisk is no longer displayed.

Whenever it is mandatory to supply information in a field, the name of the field is
displayed in red text until appropriate information has been supplied. The information
may be supplied by making a choice from a drop down list, by using the Wizard
button “x , by typing the information, or in some cases, supplied by the system
when other information have been supplied.

2.6 SLA Administration Ul Common Actions

There are a number of actions that are performed frequently when using SLA
Administration Ul. These actions are described in Chapter 3.

18



Chapter 3

Common Actions

There are many actions that will be performed frequently when using the SLA
Administration Ul application. To make these tasks easy to understand, they are
presented in this chapter.

3.1 Saving an Object

Whenever the user has created, modified or edited an Object, he should save the
object.

This can be done in several ways.

[ Click the Save Icon on the Toolbar | Saves the Object in the current
or from the File Menu. Editor.
=il Click the Save All Icon on the Saves all Opened Objects.
Toolbar or from the File Menu.
Ctrl/S Press Ctrl and keep it pressed while | Saves the Object in the current
typing S. Editor.
Important

Clicking OK at any stage of the user’s activities in creating or modifying, does not
save the work previously done, it merely takes the user to the next stage of the task.

When an Object has not been saved, an asterisk * is displayed to the right of the
word mode on the title banner of the activity window.

When the Object has been saved, the asterisk is no longer displayed.

3.2 Creating an Object

All Objects can be created in several ways:
e The New method (creating an Object from scratch)

e The Duplicate method:
this method enables the user to create an Object quickly, by copying the content
of a “reference” object. The resulting duplicated object can be edited as any other
object the copied values can be kept or modified within the new object. The
duplication process is described in Section 3.2.2.

19



3.2.1 Creating a New Object from Scratch

The principle is the same for creating all Objects, but the mandatory will vary for
each Object.

The process can be started in two ways:

1. From the File menu choose New,

or
2. Press Ctrl/N.
The option box displayed in Figure 4 will be displayed.

Figure 4 Create an Object Option Box, File Menu Method

#s, hp 0¥ SLA Administration UI

File Edit Wiew Action Window Help

Conneck B 2% | SRR >
Disconnect
& Service
(EL Open »  # Service Group
i Close Chrl+F4 ' Data Feeder
Bl save Chrl4+5 £, Customer
&l 5ave Al £y Operatian
Duplicate o Service Level
% Delete ChrlH+D SLA
w REfresh Fa @ Schedule
< Import »
=8 Expark...  ChrlH+E
E:xik

I the user clicks on the New Icon L1 on the menu bar, the option box illustrated in
Figure 5 will be displayed.
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Figure 5 Create an Object Option Box,
Menu Bar

!!, hp O% SLA Administration UL

File Edit Wiew Action Window Help
D-B8-3 | sEF| x|

D Mesn *

Whichever method used to start the process, the “class” (for example: Service) of the
object to be created has to be chosen from the option box displayed.

The proper Create dialog box will then be displayed (the Create a Service dialog
box is given as an example in Figure 6).

Important

The same information is needed for creating a Service, a Service Group, an SLA and
a Service Level. The dialog box contents are identical to the Create a Service dialog
box’, but the titles are respectively Create a Service Group, Create an SLA, and
Create a Service Level.

If the drop-down list of available Definitions is empty, or not up to date, the user

needs to click on the Refresh icon = to the right of this field to load the latest
available Definitions.

Note

Every Object must have an ID that is unique on the platform, whether generated using
the wizard button or entered manually.

If the entered Name is composed of more than 12 characters, the application takes the
first 12 characters of this Name, and adds a number to it. If no Name has been
entered, the Identifier automatically created will just be Numeric.

The following set of characters must be used for the Identifier:

o Alphanumeric characters

21
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As for the Service Definition, the Identifier field cannot be left empty, but, as long as
the Service is in Create mode, it is possible to change the value.

Figure 6 Create a Service Dialog Box
@ Create a Service

Definitiar: I‘-,-fiden LI (3

Marme: I‘v’ideu HP

+
hey
&

idertifier.  [videoHP

De=crigtion:

Ok Cancel

1. From the drop-down list, choose a Definition that the new Object will rely on.
This step is mandatory, but, as long as the new Object has not been saved, the
chosen Definition may change.

2. A Name has to be entered for the new Object.

3. A description may be filled. This field may be left empty at this stage, as it can be
modified at any time later.

4. The user needs to click the OK button to validate the creation of this Object. The
user will then start working with the Editor for the created Object, opened in
Create Mode.

3.2.2 Creating a New Object by the Duplicate Method

To create an Object by the duplicate method, the procedure, described in Section 3.7,
needs to be followed.

The user can make any modifications he wants and then save the object. Note that the
name of the newly created object, which is actually the name of the existing object
preceded by “copy of”, can be updated before saving.

3.3 Searching for an Object

The Main Menu bar gives the opportunity of searching for Objects using specific
criteria.

1. From the View menu, choose Search Panel. The menu illustrated in Figure 7 will
be displayed.
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Figure 7 Search Panel Sub-Menu

f, hp O¥ SLA Administration UI
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€3 Search Panel [l —

Service Level [ SLA

Service Deplovment
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2. The option None is the default state. However, if a Search Panel is opened,
choosing this option closes the current active Search Panel.

For each of the options (All, Service Level/SLA and Service Deployment) a window
is displayed containing Tabs for the set of Search Panels for that group of activities.
To make a search for a given Object, the user needs to click on the corresponding
Tab. The Search Panel for this Object will then be displayed.

The specific sets of Search Panels are designed to meet operational needs, for
example: the SLA/Service Level option restricts the search to the Objects used in the
creation of these Objects (illustrated in Figure 8).

Figure 8 Search Panels, SLA/Service Level Tabs
@ Search |Close the active editor (Ctr+F4) | =
@’ Service Group | £ Customer
_% Operation @ Service Level | SLA

Search for a Service Level -

Defirition: I ;I e

Identifier:

Mame:

Description:

Mz, Resultts: 1000

@Search | Qstop I

Idertifier  |Mams |pefintion |

Although Service Level/SLA restricts the search to the Objects used when designing
an SLA or SL, the user can also search for these Objects from the All option, even if,
in that case, unneeded Object searches will be made available.

o All allows searching among all Objects, which are:
& service
@ Service Group
Y2 Data Feeder
€ Customer
Bk Operation
@ Service Level
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SLA
e The Service Deployment Tabs are:
e Data Feeder
& Service
& Service Group
e The Service Level/SLA Tabs are:
# Service Group
€ Customer
[ Operation
@ Service Level
SLA

Whichever selection made from the Search Panel sub-menu, the presentation of the
tabs is the same.

The examples illustrated in Figure 9 are Search for a Service on the left and Search
for an SLA on the right.

Note

The Search criteria presented depend on the Object. Examples of Search criteria are
illustrated in Figure 9.

Figure 9 Search Panels, Maximized — Service and SLA
& Seerch = MWandatory search &) search »
E criteria .
‘3 Doz Freeder | ,L_-, Cuztomer E Cperstion | @ Servics Level | EE SLA
¥ Service | 88 Seevioe Groun ! Deta Faadsr | £ Customer
(% cpergtion | D merviceLewel R SLA & Service I B servie Grap
Searchfor an SLA = Search for a Sendce =
Definion: fugen [ = pemmion: fuidea =
Idertiner: & Ideriifiar:
Rtz Optional Search ae:
Dezaription: criteria Dezcrption
Cuatomer ey etion: MExX. Resuis: nooo
Service Leve| bame: Administrative steta: fac
Serdce Groun Meme Oparationsl sbala: |
tlaz . Results: 1 00d Avaiabilty slatus: "'I
Admiigtrative stele l Marnal Search
Cperstional stet= "I Exlerced Seatch————————————
Avalisbity status: -1 ¥
Esearcn | Dowor | | LABEL ntributennme:
dantifir | Mare |oetniton | Extendetd Search LT
Critera L
1 b
I &) Saarch I @ =trn I
Search results lidentifer  |ieme [petiniion |
Se— [ , -

The Definition field name is displayed in red text as it is a mandatory field. When it is
mandatory to fill a field, the name of the field is displayed in red text until the
required information is filled.
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1. If the drop-down list of available Definitions is empty, or not up to date, a click on

the Refresh icon = to the right of this field is necessary to load the latest
available Definitions.

2. The information * will be displayed in the field in gray while the data
is being loaded. The progress bar will indicate when the data has been loaded.
The updated drop-down list of available Definitions will then be displayed.

Figure 10 Definitions Displayed after Refresh
Search for a Serdce =
DEfinition; ﬂ ]

|dentifler nane
Marme:
Description; [SIMPlESerce

3. Select the targeted Definition, by left-clicking on the item.

The Search button is grayed until the Definition has been selected and loaded.
Extended Search is also displayed.

Note

For most Objects, the search prerequisite is to provide a Definition.

However, no Definition needs to be provided for the Objects Customer and
Operation.

The Identifier, Name and Description fields can be edited to refine the Search.
Advanced criteria can also be specified in order to filter the results:
Specify the maximum number of results displayed (Max. results),

Specify the Administrative state, Operational Status or Availability Status of
the objects to be returned.

Enter values for the extra fields of Extended Search.
4. Click on the Search button.
5. A list of the available Services will be displayed in the Search Results field.

The details that are displayed are a function of the chosen Definition.
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Figure 11 Search Results

@ Search =
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Dm. Diata Feeder | E}, Customer
& Service | @’ Service Group

Search for a Service -

Defirtion: I‘\,-"ideg LI s
Idertifier:
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Description:

Max. Resuts: 1000

Adrministrative state: |
Operational stete: LI
Availabilty status: Ll

Extended Search

] search | @ top |

dertifier | Mame | Definition
Lyom _LABEL Lyon  Video

Paris _LABEL Pariz  Video

K] I i

2 result(s) found

6. The Search can be stopped at any time by clicking on the
Stop button € . In this case, no results will be displayed in the Search Results
field.

The screen illustrated in Figure 12 illustrates the extra search criteria made available
with the Extended Search function. If the Extended Search is chosen, the criteria that
are displayed are linked with the chosen Definition.

Figure 12 Extended Search Options

Farmal Search

Extended Search

_LAEBEL sttributename:

Responsible:

When the Extended Search criteria are displayed, Normal Search is displayed
allowing the user to toggle back to the Normal Search display. Each Object displays
different Extended Search criteria. Figure 12 illustrates the Extended Search criteria
when searching for a Service.

7. The user can then double click on one of the matching Objects. The Object
window will then be displayed in Edit mode.
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3.4 Opening an Object

Apart from the Search Panel, there are three other ways of starting the process of
opening an Object: the Menu method, the Toolbar method and the Keyboard
method.

e The Menu method: from the File menu, select 2+ Open.
e The Toolbar method: click on the Open icon &£ on the toolbar.
e The Keyboard method: press Ctrl/O.

The principle of opening any Object is the same, but there are slight differences after
the first three steps for some of the Objects.

Whichever method used to start the process (with the exception of using the Search
Panel method) an Open an Object Selection box will be displayed.

Figure 13 Open an Object Selection Box

Open a Sery

54

Cpen an SLA

Mewvy | Open

1. Select the Object to open and click OK.

2. The Open an Object dialog box will be displayed. The example illustrated in
Figure 14 is Open a Service. The Open an Object dialog box is always the same
as the Search Panel’s and behaves in exactly the same way.
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Figure 14 Example of Open an Object Dialog Box
(Open a Service)

%, Dpen a Service X

@ Open a Service
cervnor: [ -| <

Identifier:

Marne:

De=crigtion:
e, Results: 1000
Adtniniztrative state:
Operational state:
Availability status:

@Search I eﬁtup I

identifier | Name |Cefintion | admin.

Ll

Kl | [

Select Cancel |

If the drop-down list of available Definitions is empty, or not up to date, the user

needs to click on the Refresh icon %= to the right of this field to load the latest
available Definitions.

The information ‘loading data’ will be displayed in the field in gray while the data is
being loaded. The progress bar will indicate when the data has been loaded.

The updated drop-down list of available Definitions will then be displayed.

Once the Object is retrieved from the Search Result, the user can either double click,
or click on Select to open it.

The Open dialog boxes for Service, Service Group, Data Feeder, SLA and SL display
the same basic fields to be completed to Open an Object, but some provide extra
criteria. See the illustration in Figure 9 for an example. Each Search Panel displays
the criteria that correspond to the criteria of the Object Definition chosen.

3.5 Refreshing an Object

It is sometimes necessary to refresh the displayed details of an Object as they may not
be up to date. An Object could have been modified outside the current instance of
SLA Administration, if this is the case, the information about the Object, opened in
Edit mode in the current editor, will not be up to date.
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To ensure that the information is correct, from the File menu or the Toolbar, click on
the Refresh button < (or press Ctrl/R) to update the content of the current editor.

Loading Data will be displayed in the window where the Object was selected, and
then the refreshed information will be available.

The refresh action is not available for Objects that are in Create mode, because they
only exist in the current instance of SLA Administration. An Object is not contained
in the SQM Repository if it has not been saved.

Important

It is not recommended to Refresh a modified Object as the modifications could be
lost (an asterisk * is displayed in the title bar after the word mode if the Object has
been modified). If the user tries to refresh the Object, SLA Administration will ask to
confirm whether or not save the changes.

warning R x|

@ The Service you want ko refresh has been modified.
Do wou really want ko refresh it and lose the modifications?

o |

If the Object to be refreshed no longer exists in the SQM Repository
(it could have been deleted) the status of the Object will revert to Create mode and
the user will be able to save it if needed.

If the Object no longer exists, a message is displayed.

3.6 Importing and Exporting Objects

Obijects can be imported into SLA Administration User Interface from an XML file.
Obijects can also be exported to an XML Definition file. The user can Import and
Export the XML definition files of all Objects with the exception of Service
Component Instances. All items that are exported or imported have the format .XML.
Exported Objects can be stored either in the SQM Repository or locally.

When the user exports some Objects, he should carefully organize the output XML
files into a meaningful structure.

This feature is available in order to be able to continue working if there is a
connection failure, as these actions are carried out locally. This feature can also be
used to recover . XML files.

3.6.1 Exporting an Object

This option is not available on the File menu unless an Object is opened.

From the File menu, select Export, or press Ctrl/E. The Export dialog box will be
displayed.
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Figure 15 Export Dialog Box

%8, Export Service... x|

Laok in: I[:I etc ;I EF

Files of type: IExtended Markup Language (xml) ﬂ Cancel |

File name:

The location where to Export the Object can be chosen by selecting the directory in
the Look in: field.

The user can click on either Cancel, or Export. If Export is selected, the Object will
be exported and a message indicating what Object has been exported will be
displayed in the message bar at the bottom of the window.

3.6.2 Importing an Object

From the File menu, select Import. The Import dialog box will be displayed.

Figure 16 Import Dialog Box

¥, Import x|

Laok in: I[:I etc LI chs

File name: I Import |
Files of tyjpe: IE)dended Markup Language (xml) LI Cancel |

The directory from which the files are imported can be chosen. The type of the files
to be imported can be either “All Files” or Extended Markup Language (XML).
Extended Markup Language (.xml) should be selected. Then the user has to choose a
file from the directory through the Look in: field.

Afterwards, the user can click on either Cancel, or Import. If a click is performed on
Import, the Object will be imported into memory and opened in Modify mode, which
means that any modification can then be performed and saved.

3.7 Duplicating an Object

Before an Object can be a candidate for duplication, it must be opened and selected.
1. Ifitis not already open, open the Object to duplicate.
2. From the File menu, select Duplicate.

3. A message indicating that the duplication was successful is displayed in the
Console window and on the information bar at the bottom of the window.

30



The duplicated Object is displayed in a new window in Create mode with a name
that is “Copy of” plus the name of the original Object. The original Object remains
displayed in its window under the newly created Copy.

An Identifier is automatically generated for the newly-duplicated Object.

The duplicated Object can then be modified and saved at will.

3.7.1 Duplicating a Service

Duplicating a Service presents an extra window. This is explained in Section 4.2.

3.8 Deleting an Object

There are two ways of deleting an Object:
o Delete the Object while it is opened,

o Delete it using the search panel.

3.8.1 Deleting an Opened Object
1. Open the Object to be deleted as described in Section 3.4.
2. From the File menu, choose # Delete.

A Pop-up box will ask the user to confirm the deletion of the Object.
(“_LABEL HP” in the example.)

@ Cio you really want to delete *_LAEEL Paris" 7
¥ Safe deletion mode

3. Click on Yes: the Object will be deleted.

Important

The Safe deletion mode check box provides a safeguard when deleting an object.
Indeed an object may have dependencies (for example, a Service may be used by one
or several Service Instance Groups which are themselves referenced by one or several
Service Level Agreements). During an object deletion, there are two ways to maintain
the model consistency within the Service Repository Manager:

— Delete the object and all the “child” objects (“Force” mode)
— Reject the object deletion if there is at least one dependency (“Safe” mode)

When the Safe Deletion Mode is checked, the deletion is performed in “Safe” mode.
Otherwise, the “Force” mode is used.

3.8.2 Deleting an Object Using the Search Panel
1. Display the Search Panels.
2. Display the Tab for the Object to be deleted.
3. Click on the Search button.
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4. Single right-click on the Object to be deleted.

5.

The pop-up Menu, giving the options to Open or Delete will be displayed.

Figure 17 Deleting an Object Using the Search Panel
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6. Clickonthe # Delete button.

7. A Pop-up box will ask the user to confirm the deletion of the Object (as with the

other method).

3.9 Viewing the States of an Object

To be able to see the States of an Object, the Object must be opened.
1. Open the Object.

2. Wait for Loading Data to complete.
3. Click on the States Tab.

There are three states for every Object:

The Administrative State, which can be:

Locked:
The resource is administratively prohibited from performing services for its users.

Unlocked:
The resource is administratively permitted to perform services for its users.

The Operational State, which can be:

Enabled:
The resource is partially or fully operable and available for use.
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Disabled:
The resource is totally inoperable and unable to provide services to users.

The Availability Status, which can be none, one, or several of:
Normal (Available)

In Test

The resource is undergoing a test procedure. If the administrative state is locked
or shutting down, then normal users are precluded from using the resource and the
control status attribute has the value reserved for test. Tests that do not exclude
additional users can be present in any operational or administrative state but the
condition reserved for test should not be present.

Power off

The resource is not powered on. For example, a fuse or other protection device is
known to have removed power or a low voltage condition has been detected. The
operational state is disabled.

Failed
The resource has an internal fault that prevents it from operating. The operational
state is disabled.

Off Line

The resource requires a routine operation to be performed to place it online and
make it available for use. The operation may be manual or automatic, or both. The
operational state is disabled.

Off Duty

The resource has been made inactive by an internal control process in accordance
with a predetermined time schedule. Under normal conditions, the control process
can be expected to reactivate the resource at some scheduled time, and it is
therefore considered to be optional. The operational state is enabled or disabled.

Degraded

The service available from the resource is degraded in some respect, such as in
speed or operating capacity. Failure of a test, or an unacceptable performance
measurement, has established that some or all services are not functional or are
degraded due to the presence of a defect. However, the resource remains available
for service, either because some services are satisfactory or because a degraded
service is preferable to no service at all. Object-specific attributes may be defined
to provide further information indicating, for example, which services are not
functional and the nature of the degradation. The operational state is enabled.

Dependency

The resource cannot operate because some other resource on which it depends is
unavailable (that is: a resource not represented by the same managed object). For
example, a device is not accessible because its controller is powered off. The
operational state is disabled.

Not Installed

The resource represented by the managed object is not present, or is incomplete.
For example, a plug-in module is missing, a cable is disconnected or a software
module is not loaded. The operational state is disabled.

Log Full
This indicates a log full condition, the semantics of which are defined in CCITT
Rec. X.735 | * ISO/IEC 10164-6.

The states of an Object can also be verified by the means of the View - Search
option. See Section 3.3.

The error text displayed in the Console (and at the base of each screen) can also give
information about the states of an Object.
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Chapter 4

Service Deployment

This chapter describes how to create and instantiate Services from Service
Definitions, create Service Groups and register new Data Feeders in the SQM
Repository.

4.1 Registering New Data Feeders

Data Feeders must be Registered and declared so that they can provide data to
monitored Services. The complete declaration of a Data Feeder is not carried out
using SLA Administration User Interface, but using the tools provided with the
Service Adapters.

SLA Administration User Interface allows the registration of a Data Feeder to be able
to complete the binding of a new Service. However, Data Feeders registered with this
process do not collect data until they have been declared with the Service Adapter
tools.

Registered or Declared Data Feeders can be used to bind Data Feeders to a Service.

The Registration of a Data Feeder is the Request for the declaration of a new Data
Feeder in the SQM Repository.

To register a New Data Feeder:

1. From the File sub-menu, choose New,
or click on the New [1 icon on the toolbar,
or Press Ctrl/N.

2. The Register a Data Feeder screen will be displayed.

Figure 18 Register a Data Feeder, First Screen
BEE: Register a Data Feeder
Definition:  [Dns DFD (v1_0) |
Mame: ||
Custamer: I
Description:

Ok I Cancel
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3. Choose the Definition for the Data Feeder from the drop down list in the
Definition field.

4. Type a Name.
5. No ID needs to be provided for a Data Feeder: it is made of the MRP.

6. If this Data Feeder is dedicated to a specific customer (i.e any measures received
on it are for the same customer), choose the associated customer in the Customer
field.

7. Enter a meaningful description text in the Description field.
8. Click on OK.

9. The Data Feeder Editor window will be opened in Create Mode. This indicates
that the Data Feeder has never been saved in the SQM Repository.

As displayed in the screen illustrated in Figure 19, there is an asterisk after Create
mode. This indicates that the Data Feeder must be saved.

Figure 19 Register a Data Feeder, Editor Window

b, * Data Feeder [MRP: Dns_] - Crea i |

Details | Manitaring States I

~Characteristics
Defintion: ~ [Dns DFD (v1_0) |
Marme: IDns Primary HP

Measure Poirt: IDns_

Custormer: I
Description:
~Properties
Mame Type “alue
Dz 1P Address Strirg

The Data Feeder has two Tabs: Details and Monitoring States. The window is
opened displaying the Details Tab, which itself has two sections: Characteristics
and User Defined Properties.

4.1.1 The Properties Tab

The Characteristics section displays the same fields as the previous screen and an
additional field, Measure Point. The properties displayed in the User Defined
Properties section are the properties that come from the Data Feeder Definition.

Important Notice

Properties of type Date (referred to as AbsTime in Service Designer) must be filled
with the following format:

YYYY-MM-DDThh:mm:ss
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T is a mandatory character. For example, the string 2004-03-25T21:00:00 represents
the twenty-fifth of March 2004 at nine o’clock pm.

The Measure Point field is displayed in red text as it is a mandatory field and remains
red until it is filled.
The way it is filled is described in the section The Measure Point Field Behavior.

This field cannot be edited directly unless no MRP Naming Schema is defined
for the Data Feeder Definition.

Importance of the Choice of Data Feeder Definition at Creation Time

While the current Data Feeder has not been saved, the editor remains in Create mode.
This means that the Data Feeder Definition can be changed at will. The choice of a
Data Feeder Definition has two impacts: it changes the Measure Point field behavior
and it updates the list of properties. This means the values chosen for the previous
properties are lost.

4.1.2 Behavior of the Measure Point Field

The behavior of the Measure Point field is driven by the MRP Naming Schema
defined in the chosen Data Feeder Definition.

Depending on the content of the MRP Naming Schema, the field is updated with the
values that are typed in the User Defined Properties section. This Measure Point
field cannot be edited directly. The values are computed by SLA Administration,
concatenating the values of the MRP Naming Schema fixed string and properties.

Let’s illustrate this behavior by looking at the MRP Naming Schema defined in the
Dns Data Feeder Definition shown in Figure 19.

<sc:MRPNamingSchema>
<sc:FixedString>Dns_</sc:FixedString>
<sc:PropertyName property.name="DomainName"/>
<sc:FixedString>:</sc:FixedString>
<sc:PropertyName property.name="Dns IP"/>
</sc:MRPNamingSchema >

The properties DomainName and Dns_IP are used to create the MRP Name. This
makes these properties “special”, they become more important than the others
because their values will be included in the final Measure Point used to identify the
Data Feeder being created.

Important

Such properties can only be edited during Data Feeder creation, while the Editor is in
Create mode.
Once the Data Feeder has been saved these properties become read-only.

If no MRP Naming Schema is defined, the Measure Point field becomes editable.

4.1.3 The Monitoring States Tab

The Monitoring States Tab has no information because the Data Feeder has not yet
been saved and is not yet operational.
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4.2 Creating a New Service

1. Follow the steps detailed in section Error! Reference source not found., Error!
Reference source not found..

2. Choose Create a Service.
The Create a Service dialog box will be displayed.

3. Click the OK button to validate the creation of this Service and start working with
the Service Editor.

The Service Editor will be opened in Create mode (with an asterisk (*) indicating that
the Object has not been saved). The editor window has two sections, the Service tree
Hierarchy on the left, and the Property Editor on the right, displaying the properties
of the node currently selected in the tree hierarchy. The Property editor has two Tabs
available in Create mode: the Properties Tab and the Data Feeder Tab. It is displayed
with the Properties Tab open.

Figure 20 Create a Service, Service Editor,
Displaying the Properties Tab

#* Service [Yideo HP] - Create mode ;IEIEI
b#ihideo HE [Video UL
@- IPAccess {111} Detailz |States| Data Feeder | Diagnose
[ WebServer {1/N} .
Characteristics
Definition: ~ [video A

Mame: I\-"idBD HP

Ifertifier: IVIDEOHF’?BSS

Description:
~Properties
Marme IType “alue
_LABEL sttributenarme String
Fesponzible String

4.2.1 The Service Hierarchy Tree

The Service tree shows a hierarchy of Service Components under the Service root
node. When a new Service is edited, the tree displays only the mandatory Service
Component Definitions defined by the chosen Service Definition (those having a
minimum multiplicity not equal to zero). The multiplicity of the Service Component
Definition node is shown between braces {1/1}.

Service Component Definition Icons
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€ Service Component Definition —
Not Shared

el Shared Service Component Definition

There are situations when no child node is displayed under the root node. This can be
because the minimum multiplicity of the first level child Service Component
definitions are equal to 0, or that there are no child Service Component Definitions.

By default, the tree selection is on the Service root node. Choosing another node
changes the content of the property editor. When a Service Component Definition is
selected, the properties displayed are read-only. It is not possible to change the
content of the Service Definition. The information displayed on the Data Feeder tab
is grayed.

4.2.2 Creating a Service, Property Editor

The Property Editor is composed of several tabs, each of which displays the
properties of the node currently selected in the tree hierarchy, whether Service,
Service Component or Service Component Definition.

The name of the node for which details are displayed is also indicated on the top
right-hand side of the window outside the Tabs.

Whenever the user clicks on a node in the tree hierarchy, its name is displayed in this
label at the top right-hand side of the window.

If the root node is selected, the name of the Service is displayed.

If a Service Component is selected at any level of the hierarchy, the label displays the
name of the Service and the name of the Service Component in the format:

Video HP/_LABEL IPAccess, where the Service is Video HP and the Component is
_LABEL IPAccess

4221 The Details Tab

The Details Tab has two panels, Characteristics and Properties.

42272 Characteristics Panel

The Characteristics panel displays the global properties (Definition, Name, Identifier
and Description) of any object the GUI deals with. This generic panel is present in
several other editors.

4.2.2.3 Properties

The Properties panel displays the properties that are specific to the Service Definition
chosen. It is impossible to add new properties, but when a Service or a Service
Component node that contains properties is selected, their values can be edited.

In the example, these are Location and Responsible (Contact Name).
To enter a Value, or change an existing one:
1. Select an item (the Location or Responsible in the example).

2. The Value field will become available. Click on the Value field and type a value.
There is no limit to the number of characters that the user can use.

4224 The Data Feeder Tab

Data Feeders must be bound before they become effective for a Service, refer to
Section 4.3 for details of how to bind Data Feeders.
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4.2.25 The Diagnose Tab

Diagnose tab is activated only when Service diagnose has been selected (see 4.5).

4.2.3 Duplicating a Service

When a Service is duplicated, after the initial Duplicate action, the dialog box
illustrated in Figure 21 is displayed.

When checking the share components checkbox, the share Service Components are
re-used from the original service to the new one (i.e. with the same identifiers/labels).
Otherwise, the shared components are themselves duplicated.

Checking Prefix/Suffix checkbox and entering a value for the prefix and/or suffix will
impact the identifiers and labels of the created objects.

Figure 21 Duplicating a Service
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4.2.4 Instantiating a New Service

The process of instantiating (or deploying) a Service is to create (or re-use) Service
Components according to the content of the Service Definition.

Service Components can only be accessed by means of the Service Editor as they are
always attached to a specific Service.

Components can be created or re-used by Duplicating the Component Object.
To do this,

1. Open the Service to be reproduced,

2. Select the Component to be re-used in the Tree Window,

3. Then from the File menu, select Duplicate.
4

. A message indicating that the duplication was successful is displayed in the
Console window and on the information bar at the bottom of the window.

The duplicated Object is displayed in a new window in Create mode with a name
that is Copy of plus the name of the original Object. The original Object remains
displayed in its window under the newly created Copy.

An Identifier is automatically generated for the newly-duplicated Object.

5. The duplicated Object can then be renamed, modified and saved at will.
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Understanding the Service Editor Model Representation

The Service Definition model designed with OpenView Service Quality Manager
Service Designer (illustrated in Figure 22) will help to explain the Service Hierarchy
Tree illustrated in Figure 23.

Figure 22 Service Designer Model Definition
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When a new instance of this model is created, the Service editor tree displays the
hierarchy illustrated in Figure 23.

Figure 23 Service Hierarchy Tree for the Model Illustrated in Figure 22

did

-3 _LABEL IPAccess {111}
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The root node representing the Service is automatically instantiated with the
properties entered in the Service creation screen.

Below the root node, there are the Service Component Definitions IPAccess and
WebServer. The WebCam Service Component Definition is not displayed because
the minimum multiplicity is zero (therefore this component is not mandatory).

At least one Service Component has to be created for each displayed Definition to be
a valid Service.

There are two ways of doing this: either create Service Components one by one, or
use the Auto Instantiate feature.

Auto Instantiating a New Service

Auto Instantiating a Service Instantiates a Service with the minimum required
Components.
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4243

To Auto Instantiate a new Service, right-click on the Service root node to display the
pop-up menu illustrated below, and click on Auto Instantiate.

+_ Auka Instantiate

% add Mew Component J
tg #dd an Existing Campanent  k

The Service Component Definitions are replaced by new Instances of Service
Components.

] South MWide

E| Q [+ e LAEIELIF'A::::ESS IPACcEss]
------ {# New _LABEL Dns [Dns]

E| g Mew _LABEL WehServer [ebServer]
------ ;g Mew _LABEL Platform [Platform)

The red star at the top right-hand side of each icon indicates that the component has
just been created and must be saved before it can be accessible through the Service
Quality Manager platform.

The new Service Components are saved when the Service is saved.

Instantiating a Service Manually

Auto Instantiating a Service may not always meet the user’s needs, for example when
existing Service Components need to be referenced in the new Service.

The Service can be instantiated gradually using the pop-up menus available by right-
clicking on the Service Hierarchy tree nodes.

g’ CLCA Video System - South [Wideo]
E| @ Mew _LABEL IPACcess [IPACcess] i
------- (3 _LABEL Dns {1/N} FrerEi
E| U Mew _LABEL WehCam MehCam]
------ Q Mew _LABEL Platform [Platfarm)

E_ Auto Instantiate i

Cammc

% Instantiate

‘% Assign an Existing Component.. 4
I

Service Component Icons

Q2 Service Component — Not Shared

o New Service Component — Not Shared,
New indicated by a red star.

e Locally shared Service Component

= New Locally shared Service Component,

New indicated by a red star.

Globally shared Service Component

: ©

New Globally shared Service Component,
New indicated by a red star.

Actions Available from the Service Tree Hierarchy
Window

‘ - Automatically creates all the mandatory Service
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Auto Instantiate

Components starting from the selected node.
This action is available on any node selection
(Service, Service Component and Service
Component Definition).

3

T Creates a new Service Component for the

Instantiate selected_ Definition. This ac_ti(_)r_l is only availa_bl_e
on Service Component Definitions and only if its
parent node has been instantiated.

3?3 This action opens a dialog box to obtain the list

Assign an Existing of all available Shared Service Compo_n_ents for_
the selected Service Component Definition. This

Component...

action is available only if the selected SCD
allows sharing and if the parent node has been
instantiated.

to.

Add New Component

According to the tree node selected, this action
displays a list of all available Service
Component Definitions for which new Service
Components may be created. Once the
Definition is chosen, a new Service Component
is created and added as a child of the current
selection. This action is available only on
instantiated nodes (Service or Service
Component).

tex

Add an Existing Component

This action displays a list of all available Shared
Service Component Definitions for which
existing Shared Service Components may be
used. Once the Definition is chosen, a dialog box
is opened to obtain the list of all available Shared
Service Components. Choose a Service
Component from the list. It will be added under
the currently selected node. This action is
available only on instantiated nodes (Service or
Service Component).

Duplicate Component

Adds a new duplicated Service Component at the
same level as the selected Service Component.
This action is only available on Service
Component and if multiplicity allows it.

G

Remove Component

Removes the selected Service Component. This
action is only available for Service Components.
The action ONLY removes the Service
Component. It DOES NOT Delete it. It is SQM
Repository which manages the Deletion of
Objects.

4.3 Binding and Unbinding a Data Feeder

Binding a Data Feeder is the act of linking the supply of information to the Service or

Service Component.

Two kinds of Parameters exist for a Service or Service Component:

e Primary Parameter (collected parameter)
where a Data Feeder supplies its information directly to the Parameter

or
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e Secondary Parameter (computed parameter)
where the value is computed from other Service or Service Component
Parameters.

The type of Binding and calculation method for a Parameter is determined in Service
Quality Manager Service Designer at the Definition stage.

At the Service Instantiation stage, secondary Parameters are automatically computed
based on the operations defined in the Service Definition. For primary Parameters, a
data source must be selected. This is the action of binding a Data Feeder to a Service.

To do this, the Data Feeder Tab of the Service Editor must be used. This Tab is only
active for Service Components that have Primary Parameters and therefore require a
Data Feeder.

The Diagnose function (described in Section 4.5) will also help the user to bind Data
Feeders to a Service, as it displays all the required Data Feeders in a single list.

4.3.1 Binding a Data Feeder
To bind a Data Feeder:
1. Open a Service as described in Section 3.4. The Service will open in Edit mode.
2. Select a Service or Service Component in the Service Tree hierarchy
3. Click on the Data Feeder Tab.
4. Right click on the Data Feeder to be bound to this Service or Service Component.
5. Ifitis not already bound, the Bind button illustrated in Figure 24 will be

presented.

Figure 24 Bind a Data Feeder Button

¥ * Seryice [Wideo HP] - Create mode =10l x|
g’ K mm. HP [viden] Video HP
3 MNew IPAccess [IPAccess] Detailsl States Data Feeder | Diagnosel

H = Q Mew Dns [Dns]
=8 g Mew WebServer WebServer]
------ &2 Mew Platform [Platform]

Zo_niviedisDr_ e
SrvHealthGua_2358
SrvHealthearly_w1_0
Crviz_MetweorkDF 1 _0
SrvHealthhonthly w1 _0
'S0 _DFDincident w1 _0

K1 [

.2 Jze Right cfick to edit o Dsta Feeder

o

Click on the Bind button.

. The Open a Data Feeder dialog box will be displayed, with the Search Results
field already filled in with the occurrences of this Data Feeder.

~

8. Select the occurrence of the Data Feeder to be bound.

9. The Data Feeder Tab will be re-displayed. Moreover the Adm. State, Op. State
and Avail. Status details will be now displayed.

4.3.2 Unbinding a Data Feeder
If a Data Feeder, has to be unbound, simply right click on it to Unbind it.
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4.4 Managing Service Data Collection

The Administrative State of the Services should be managed only through the SLA
(see section 6.4.6 for more details), this guaranty that only useful data are collected.
Anyway during integration there will be sometimes the need to stop or start collecting
Data for a specific Service. This can be done by using the Suspend/Resume Action.

To suspend a Service:
1. Open a Service.

2. Select the Service in the tree window.

3. From the States Tab, click on the ® Suspend button. (The Suspend button is a
red square).

Use the Resume Action to start the collection of data.

The Resume Action sets the Administrative State to UNLOCKED. This action
restarts data collection for the whole Service. If needed, the collection is also re-
started on child Service Components/Data Feeders. The procedure is the same as for

stopping data collection, but using the ® Resume button. (A green triangle.)

These actions are also available from the Action Menu, on the toolbar, or by pressing
the Characters underlined (S for Suspend and R for Resume).

4.5 Diagnhosing a Service

When a Service is opened, it is in Edit mode.

1. Todisplay a list of all the Service Components, details of their Data Feeders and
their States, and the Availability Status,

2. Go to the Diagnose Tab,
3. Click on the Diagnose button at the bottom of the Diagnose panel,

4. The results of the diagnosis are displayed in the Diagnose panel. An example is
illustrated in Figure 25.
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Figure 25 Diagnose Results

_LABEL Paris
Detsils | States | Data Feeder Disgnose |
L1 Click on the Disgnose button to refresh the table cortent
Service Component Diata Feeder
_LABEL Paris MRP: Paris 155
_LABEL Paris WRP: Mmedia_Paris1
_LABEL Paris WRP: Pariz
_LABEL Paris WRP: Pariz
_LABEL Paris MRP: Met_172_20_40_12svc_Paris
_LABEL Paris WRP: Pariz
_LABEL Paris MRP: CrvSd-incident-bulmgulm_bbn_kbgp_o

_LABEL platform-Carmieh  MREP: Band_Platform-Carmtviek
_LABEL platform-Carmiieh  MRP: Cpu_Platform-CatrivebCpu
_LABEL platform-Carmiieh  MRP: TeMIP_BP_Platform-SMTP
_LABEL platform-Camiieh  MRP: Platform-CamiMeh

_LABEL IPAccess MREP: p_172_20_40_125tstusST

_LABEL IPACcess MRP: Met_172_20_40_12access

_LABEL dns_sec MRP: Drns_Server_16_100_200_2

_LABEL dns_sec MRP: Drs_16_100_200_2

_LABEL dns_sec MFP: Drsd_172_20_40_1216_100_200_2
_LABEL dns_prim MRP: Drs_Serwver_16_100_200_1

_LABEL dns_prim MRP: Drs_16_100_200_1 oo
_LABEL dnz_prim MFP: Dregd _172_20_40_1216_100_200_1

| LRFl ramParis MEP- Mmedia Paris? T
4 L3
Diagnose |

The details displayed on the Diagnose Tab are information details of the Service; they
cannot be edited from this display.

When a service component is displayed in the Diagnose Tab, the Service Hierarchy
view is updated to point out the selected Service Component. At this stage, it is
possible to switch to the details of this Service Component and edit it normally.

4.6 Creating a New Service Group

A Service Group is a set of Services that have the same Service Definition.
1. Follow the steps from 1 to 3 of section 3.2.1Creating a New Object from Scratch.
2. Select Create a Service Group.

3. The Create a Service Group dialog box will be displayed. In the same way as for
Creating a Service, choose a Definition from the drop down list, Type a Name
and type an Identifier, or click on the Wizard button “ to create an Identifier

automatically. Type a Description (not mandatory) and click on OK when
finished.
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Figure 26

@ Create a Service Group

Create a Service Group dialog Box

Drefinition: IVideo

Mame: I\-’ideu HF Group

Icderitifier: I\-"IDEOHPGROUP

+,
4

F

Description:

Ok I Cancel

4. The Service Group editor window will be displayed in Create mode. It has three
Tabs: Properties, States and Services. The Properties Tab is the one presented

when the Editor window is first displayed.

Figure 27

Create a Service Group, Properties Tab

4% * gervice Group [¥ideo HP Group] - Create mod =10l
[BEfai | montoring states | services |
~Characteristics
Definttion: ~|video ~|
Marme: IVideo HF Groug
Idderitifier: IVIDEOHPGROUP ey
Description:
—Properties
It Type Yalue
_LABEL sttributenarme String
Respansible String

4.6.1 The Details Tab

The Details Tab has two sections Characteristics and Properties:

Characteristics displays the information entered on the previous screen. These

details can be modified until the Service Group is saved.

Properties

The information displayed here is a function of the Definition chosen.

To enter or edit values for the User Defined Properties:
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1. Select an item.

2. Left click on the Value field and type a value.

4.6.2 The Monitoring States Tab

The Monitoring States tab will not contain any information as the Service Group is

new.

4.6.3 The Services Tab

The Services Tab allows the user to add Services to the Service Group. (And later

remove Services from the Service Group.)
Figure 28 Create a Service Group, Services Tab

4% * Sapyice Group [¥ideo HP Group] - Create n

Detailz | Monitoring States _______ I

L2 To edt & Weight, click on the cell

=10l x|

Identifier Mame ¥ IDefinitiDn Weight

Al Femove

The Tab is empty until the user has added Services to the Group.

4.6.4 Adding Services to a Service Group
To add Services to a Service group:
1. Click on the Services Tab to display it.
2. Click on the Add button at the bottom of the screen.

3. The Open a Service dialog box is displayed with the Definition field already

filled and grayed.
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Figure 29 Open a Service Dialog Box for Adding a Service

f, Open a Service x|

@ Open a Service

Drefinition:

Identifier:

Matne:

Descrigtion:

bz, Resuts: 1000

Administrative state: =]

Operational state: LI

Availability status: ﬂ
Extended Search

@Search | QStop |

idertifier [ Nams |petintion | admin. State |oper_ State | awail Status
Lyom _LABEL Lyon  Video Unlocked Disabled Failed
Paris _LABEL Pariz  Video Unlocked Disabled Failed

2 result(s) found

Select I Cancel

4. When the data has been loaded, it is displayed in the Search results field without

having to perform a search.

5. A Service to be added to the new Service Group can be chosen from the ones

displayed. Only one Service can be added at a time and only existing Services

can be added.

6. Select a Service to be added to the Service Group, the Open a Service dialog box

will close and the details of the newly added Service will be displayed on the

Services Tab.
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Figure 30 Services Tab With One Service Added

4% * gervice Group [SIGY¥ideo] - Create mode =10 x|

Detailsl Moritoring States  Services |

L2 To edit a\Weight, cfick on the cel

Idderitifier arme ¥ IDefin'rtiu:un Weight
Lyan _LABEL Lyon “idea 100%

Remaoyve |

The Weight of the Service may be changed.
7. Select the Service and left click on the Weight cell.

8. When all the needed Services have been added to the Service Group (there must
be at least one), Save the Service Group.

4.6.5 Removing Services from a Service Group
Services can be removed from a Service Group, if needed.

Removing a Service from the Service Group does not delete the Service, it merely
removes it from the current Service Group.

When there are Services in the Service Group, the Remove button is active and can
be selected to remove a Service.

When it is finished, click on Save.
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Chapter 5

Service Levels

A Service Level is the set of parameters and limits that define the level of service

expected by the Customer, or the parameters and limits defined for Operational
SLAs.

5.1 Creating a New Service Level

1. Follow steps 1 to 3 in section 3.2.1 Creating a New Object from Scratch.

2. Whichever method used to start the process, choose Service Level from the option
box that is displayed.

Figure 31 Create a New Service Level, First Screen
|

Craate & Sarvice Lava|

Definition: |'L-'i|:|E|:| j i

Marne: |50l

Identifier:  [30LDY318 :

Die=cription:

cancal

3. Type a Name.

4. Type an ldentifier, or click on the Wizard button “%. on the right of the
Identifier field to create an Identifier automatically. Note that the wizard uses the
Name previously entered as the basis of the identifier, adding a number to it.

5. Type a description (optional).
6. When done, click on OK.

7. The Service Level editor is displayed in Create mode.
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5.2 Setting Objectives for Parameters

Figure 32

Create a Service Level, Second Screen

!&. hp O¥ 5LA Administration UI
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% service Level [Gold] - Create mode
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D Cuiaterly curmulated OK time

- |E] Guaterly cumulated degraded time
D Guaterly cumulated failure time

- [ Weskly SA percentage

D SaPercentage

Iﬂ Daily mean time to repair

-|E Daily cumulated degraded time

- [E Monthly Sa percentage

D Monthly mean time between failure

- [ Monthly mean time to repair
D Monthly cumulated Ok time

Iﬁ Minthly turilatad failire timnl _'ﬂ
»

jGold] =
_LABEL Dawnload Duration

_LABEL IPACcessOP

_LABEL NbDwnidMaovies

_LABEL MbErrars

_LABEL OperationalState

_LABEL WebCamOP

_LABEL WehServerOP

[ manthly cumulated dearaded time

[ Guaterly mean time ta repair

[ Mean time hetween failure
= Daily cumulated OK tirme

[E Daily cumulated failure time

Characteristics I

Defintion: IV\deo

Marme: IGo\d

Ielentifier: IGOLDQ31 El

Description:

Console

3 Jan 12, 2004 2:38:49 P - Applicstion is started
@ Jan 12, 2004 2:38:56 PM - Application onling and connected to the server

lService Level: Gold

All items in the left-hand tree hierarchy window are grayed when the editor is
opened, meaning that no objective has yet been defined.

1. Select a Parameter in the tree window.

The Parameter Details are displayed in the right-hand window, along with the
Extended Properties for this item, which are also displayed in a separate panel at the
bottom of the window. These Characteristics and Properties cannot be edited, as they
are the standard properties of the Model for the Definition chosen on the previous

screen.
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Figure 33 Parameter Information Window, Create a Service Level
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Conzole @ x
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@ Jan 12, 2004 2:38:56 PM - Application onling and connected to the server
lService Level: Gold El

2. All the icons in the tree window are grayed until an objective has been created for
them.

3. Right-click on the Parameter item in the tree window. The Create SLO button is
displayed.

4. Click on this button. The item becomes active in the Tree Window. The right-
hand window displays three tabs: SLO Details, Thresholds and Parameter
Details. The Tabs are discussed in detail in the following sub-sections.
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5.2.1 The SLO Details Tab
Figure 34 Create a Service Level Objective, Properties Tab
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bervice Level: Gold 35

5.2.1.1  Characteristics
The following SLO characteristics can be set in this tab:

o Name: by default, it is set to the parameter Name

o ldentifier: by default, it is automatically generated from the Parameter Identifier

field.

o Description: a free text field that is set by default to the parameter description.

5.2.1.2 Default Action

When a Service Level Objective is violated, OpenView Service Quality Manager is
able to call an external Action Executor and perform a predefined action to raise an

Alarm to an External system.

The values defined here are used when they are not defined at the Threshold level.
See paragraph 5.2.2.2 for more information. The Default Action is set in the same

way as Threshold Actions.

5.2.1.3 Weight

The SLO weight, in percent is set in the Weight field of the Extended Properties
panel. The SLO weight is the relative impact of the SLO status on the Component

Service Level status.
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5.2.2 The Thresholds Tab

Thresholds define in what state a Service Level Objective is. A SLO can be in one of

the following states: Normal, Degraded or Violated.

The Thresholds Tab allows setting the threshold types and their values. It is the Tab

where most tasks are performed. It is illustrated in Figure 35 showing the crossing
type Up.

Icons Used in the Parameter Thresholds Panel

Threshold Icons
w Green Flag:
Degradation Clearance Threshold.
¥ Orange Flag:
Violation Clearance Threshold.
Orange Cross:
Degradation Threshold.
x Red Cross:
Violation Threshold.
k4 Delete Selected Threshold

The tab is divided into three main areas:

e The Threshold Crossing type and its preview,

e The Thresholds area that includes a list of the thresholds already existing, with
columns for Type, Name, Objective State, Parameter and Degradation. Below,

there is the Identifier field, and below this the Description field — a free-text field.

Each Threshold must have a value.

e The Actions area, where the default actions are displayed if any has been defined
for the currently selected Threshold.
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Figure 35
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The Crossing Type

For each of the SLO items, the Threshold crossing type (Up, Down, Equal, Not
Equal, and Is Valued) should be set. A preview of the type of crossing is given in the
panel to the right of the Crossing Type box.

The Threshold Crossing type is chosen using the drop-down menu. The Thresholds
panel is updated according to the selected Crossing Type.

Up Parameter crossing type

Preview——

Crogsing type : Preview
oo gl N

This tymer permils &n action b be

and . ; ’T
This type permits an action to
Down e

he executed on a threshold
crossing

—

engcLted on @ threshold crossing

The Up and Down crossing types allow a more precise control of the
Service Level Objective.

The thresholds are crossed either in an upward or downward direction
depending of the selected type (Up or Down).

This type is used for the definition of a series of Thresholds where the
Service Level Objective becomes more and more degraded until it

reaches a Violation State. The Clearance Thresholds (Optional) define
the parameter values at which the Violation or Degradation state stops
when crossed in the opposite direction of the violation.

The Thresholds definition panel is illustrated in Figure 36. Details are

given in Section 5.2.2.

Equal There is a violation if the Service Level Objective is equal to the
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selected value. Otherwise, the state is Normal.
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Not Equal

This setting is the opposite of Equal. There is a violation if the Service
Level Objective is not equal to the selected value. Otherwise, the state
is Normal.
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Is Valued

There is a violation if the Service Level Objective has a value.
Otherwise, the state is Normal.
Pararneter crousing tme Privvitw |

This type permits you to defding a value cbjecive.
Thiss rnisans thal an ACHon can bi execulin if heny
I no vaiue

5.2.2.1 Up and Down Crossing Thresholds

Here is an example:

e To monitor a CPU Load, the Normal state has been set at 60%.

o Therefore, if the CPU Load is below 60%, the state is normal.
o |f the CPU Load reaches 60%, but stays below 80%, the state is degraded
e When the CPU Load goes above 80%, the state is violated.

e When the state is Violated, the violation status remains Violated until the CPU
load falls below 70%.

To model this CPU Load Objective, the UP crossing type will have to be used with
the following Thresholds:

o A Degradation Threshold with a value of 60 (%), and a Degradation Factor
between 0 and 100% depending on the severity.

e A Violation Threshold with a value of 80 (%). The Degradation Factor will be
100% as it's a violation.

o A Degradation Clearance of 70% to indicate the end of the Violation

The following rules apply to UP and DOWN Crossing types:

o Violation Threshold is mandatory (it cannot be removed it from the list).

Note

The Violation Threshold cannot be deleted directly. The only way to do this is to
delete the Service Level Objective itself.

¢ Any number of Degradation Thresholds can be defined.

e The threshold list can contain an optional degradation clearance and an optional
violation clearance.

57




In the situation where no clearance exists, the Service Quality Manager considers that
the violation or degradation status is cleared when the SLO crosses the same
threshold in the opposite direction.

In the example above, no Degradation Clearance has been set, therefore the SLO will
return to the Normal state when the CPU Load drops below the 60% threshold.

The UP Crossing type is used here to monitor the CPU Load, because the SLO
becomes degraded when the value is higher than the specified level.

Other kinds of SLO have the reverse behavior: the problem appears when the value
falls below the specified level. A typical example is the Free Space on a hard disk. To
monitor such an SLO, use the Down crossing type.

For yet other kinds of SLO, the value has to remain between two levels. The
temperature is an example of this. In this case, two Service Level Objectives have to
be defined, one with the Up crossing type to ensure that the temperature is not too
high, and the other with the Down crossing type to ensure that the temperature is not
too low.

Figure 36 SLO Threshold definition area for Up and Down Crossing
Types
- Thresholds
Type |Mame Chjective State Paramet.. & |Degradatio...
Degradation 1 Degradation Factor
® Violation Violated 100%
entfier:
Description: jl

The various columns define the thresholds Type, Name, Objective State, Parameter
and Degradation.

Thresholds are added and removed by means of the popup menu that is displayed
when right clicking in the Thresholds area.

The popup menu actions are:

e Add a Degradation Threshold
e Add a Degradation Clearance
e Add a Violation Clearance

o Delete a Threshold
(only available after some values have been created).

Figure 38 illustrates the actions possible for the Threshold selected in Figure 37.

Figure 37 Example of a Thresholds Panel Pop-up Menu for Threshold
Selected in Previous figure

% ndd Yinlation Clearance

¥ ndd Degradation Clearance
Add Degradation Threshold

# Delete Threshold
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5.2.2.2 Threshold Actions

The Actions Area

When a Service Level Objective is violated, OpenView Service Quality Manager is
able to call an external Action Executor and perform a predefined action to raise an

Alarm to an External system.

The Actions Area allows to Add, Edit, or Remove Actions.

Figure 38 The Actions Area
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Adding an Action
1. Select a Threshold.
2. Click on the Add button at the right of this area.

3. The Action Editor will open.
Figure 39 The Action Editor

¥, Action Editor x|

h:! Action Editor

Executar:

Description: ’This executor sends Service Alarms to HP OWO

Action; ISend Message LI

Aditional Info.: |

On Argument: I

Off &rgument: I

Drezcription: ’

Cancel |

© N o 0 &

Choose the Executor from the drop-down list.
Choose the Action Name from the drop-down list.
Add any additional information in this free text field.
Add optional On/Off Arguments

Click on OK.
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9. The Action is created and the Action information is now displayed in the Action
Avrea.

Editing an Action

Existing Actions details can be edited:

1. Select the Action to Edit.

2. The Edit and Remove buttons become active.

3. Click on the Edit button.

4. The Action Editor is displayed.

5. Follow the procedure described for adding an Action to modify any of the Action
details.

Removing One or More Actions

Existing Actions can be removed. The procedure is the same as for Editing an Action.

1. Select the Action to be removed.

2. The Remove and Edit buttons become active.

3. Click the Remove button.

Note: all the actions can be removed at once by clicking on the Remove All button,

even if no Action is currently selected.

Action Executors

Action Executors are defined in a properties file (editable). It is stored in:
<Installation
Directory>UI\SLAClient\properties\AvailableActions.xml

Default Actions

If no Action is associated to a Threshold, SQM executes the default Action defined in
the SLO tab.

5.2.3 The Parameter Details Tab

This Tab is an Information Tab, displaying the parameter details pertaining to the
Object. These details belong to the Service Definition and cannot be modified here.

This Tab is the only one displayed when no SLO has been defined for the Parameter.

5.2.4 Adding a Component Service Level or Service Level

5.24.1

Objective

Adding a Component Service Level

Component Service Levels can be added when creating a new Service Level or when
modifying an existing one.

1. Right-clicking on the root item in the tree hierarchy will display a pop-up menu,
giving the opportunity to Add a Component Service Level or to Add a Service
Level Objective.

2. Click on Add a Component Service Level to display the Components available.
They will be displayed as shown in Figure 40.
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Figure 40 Add a Component Service Level Pop-up
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3. Select an Item from the pop-up displayed. Dns will be used in the following
example. Left-click on Dns.

4. The Component Dns will be activated in the left-hand tree window. Its icon will
change from @ to £ with a red arrow attached to it.

5. Right-click on this Object.

6. The Add Service Level Objective pop-up for this item with its options will be
displayed.

7. Select an option, it will be activated in the tree window in the hierarchy and its
icon will be , indicating that the values can be set.

8. Set the values as described in Section 5.2.3.
9. Continue this process with each of the items for Objectives should be added.

10. Save the Service Level.

5.2.4.2 Adding a Service Level Objective

Service Level Objectives can be added in two ways. One way is using the procedure
described at paragraph 5.2. The other way is described below:

1. Right-click on the Root Item in the tree window, or on the Component Service
Level that contains the Parameter to monitor, to display the pop-up option menu.

2. Select an Item from the pop-up displayed.

Figure 41 Add an Objective Pop-up,
Add a Service Level Objective
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mgl _ﬁggtgﬁgownloadedhﬂw [ SCVL_INSTANCE
| ©-42 _LABEL IPAccess [ scvL_sLa
(3 _LABEL Platform [E wehCamor
9 _LABEL WehCam
| = - WehSereropP
| F-(@ _LABEL VWehServer EI

The Objective is added (activated) in the Tree window (The icon is already there,
grayed) and its color changes to green.
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Note

Up to two Service Level Objectives can be created per Parameter. Creating two
Service Level Objectives for a Parameter is mandatory when the value has to remain
between two levels. The procedure described above is mandatory for the second SLO.

5.2.4.3 Deleting a Component Service Level or a Service Level
Objective

Once a Component Service Level or Service Level Objective has been added, it can
be deleted using the pop-up displayed when right clicking on it. There is no
confirmation. The only way to recover an inadvertently deleted item is to recreate it
or to reload the Service Level from the repository.

5.3 Modifying or Editing a Service Level

Open the Service Level to be modified.
The SLA is opened in Edit mode.

Follow the same procedures described in Section 5.1 for creating a Service Level.
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Chapter 6

Service Level Agreements

This chapter describes how to create Service Level Agreements , deploy, use and
manage Services.

Service Quality Manager allows to define two types of Service Level Agreements :

e A Customer SLA: this is the contract between a service provider and a customer,
which specifies in measurable terms, the quality of service the provider supplies
to the customer. Everything is measured in terms of the service provided to the
Customer. The OpenView Service Quality Manager Customer Object is used to
define this type of SLA.

and

e An Operational SLA: used to define infrastructure requirements for everything
from help desk services, network performance and availability, application
performance and availability, and internal processes. The OpenView Service
Quality Manager Object Operation is used to define this type of SLA.

From the point of view of HP OpenView Service Quality Manager SLA
Administration application, there is no difference in the way these SLAs are created,
nor in the way they are stored and manipulated.

6.1 Before Creating a Service Level Agreement

Before a Service Level Agreement can be created, certain Objects must already exist:
there must be either a Customer Object or an Operation Object. There must also
be a Service Instance Group (SIG) and a Service Level (SL). The Service Instance
Group must have at least one Service Instance.

Creating Services and Service Groups is described in Chapter 4.

Creating Service Levels is described in Chapter 5.

6.2 Customer

In HP OpenView Service Quality Manager, a Customer is a company or organization
that uses the services provided by a service provider, based on a contractual
relationship. OpenView Service Quality Manager SLA Administration application
enables the establishment and management of this contractual relationship, the
Service Level Agreement or SLA.

6.2.1 Creating a New Customer
To Create a Customer,

1. Follow steps 1 to 3 in section 3.2.1 Creating a New Object from Scratch. The
Create a Customer Dialog box will open.
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Figure 42 Create a Customer Dialog Box

frew x|

g Create a Customer
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Description: [This is a neww Customer

Cancel |

2. Enter the Customer Name.

3. Type in the Customer Identifier, or click on the Wizard button "% to the right of
the Identifier field to create an Identifier automatically.

4. Type a Description (optional).
5. When done, click on Ok.

Reminder

There is no need to select a definition when Creating a Customer.

6. The Customer is created and the Editor window is displayed in Create Mode.

Figure 43 Customer Editor Window, Create Mode

 * Customer [HP] - Create mode =0l x|

~Characteristic:

Rlatne: IHP
Identifier:  |HP9O7 s,

Description: [This iz & new Custamer

—Additional Information

Addtional Info.1: |

Addtional Info. 2 |

Addtional Info. 3 |

All the displayed text fields can be modified while the Customer Editor remains in
Create mode. The Additional Info fields are free to enter supplementary information.

7. Save the Customer.
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6.2.2 Modifying or Editing a Customer

After saving the Customer Object, it is re-displayed in Edit mode. The Name and
Description fields are no more editable.

6.3 Operation

A SLA Administration Operation is the operational type of SLA that is used to
define requirements internally for everything from help desk services, network
performance and availability, application performance and availability, and internal
processes. These are infrastructure requirements that do not depend on a particular
Customer.

The Operation creation process is the same as for a Customer. The Dialog boxes and
the Editors, whether in Create or Edit mode, are identical, with the exception that the
title is Operation and not Customer.

6.4 Service Level Agreement (SLA)

Once all the necessary Objects for a Service Level Agreement are in place, the
Service Level Agreement itself can be created.

6.4.1 Introduction

OpenView SQM supports both SLA status and SLA Compliance. If a service has an
availability objective defined as “99.5% daily available,” then the availability status
refers to an instant availability value (e.g.: 99.0%) whereas the compliance refers to
the accumulation of time during which the service was not available. Therefore, over
the defined time period, the SLA compliance can meet the 99.5% daily average value
although some of the SLA status measurement during that day might have been
below 99.5%.

6.4.2 Compliance

A Service Level Agreement generally defines “in service” hours for a specific
Service or an underlying Service Component. The service hours represent the hours
of the day during which the Service availability is relevant. The Service Hours
Configuration is available at the SLA level. The Service Hours are expressed as a
schedule.

The Service Level compliance is calculated based on the comparison of an SLO with
the violation threshold (during “in service” hours).

When the SLO crosses the violation threshold, the Service Level becomes non-
compliant. Non-compliance time is accumulated until the SLO is once again below
the violation threshold.

The Compliance Violation Level (CVL) is expressed as the ratio between the non-
compliance accumulated time and the total allowed violation duration for this Service
Level.
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The non-compliance time is accumulated over the contractual reporting period called
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Example

For a reference period of 1 month, the service is offered at 8-8 M-F, meaning from
8:00am until 8:00pm Monday to Friday.

So, the overall in-service time for this reference period is 22 open days, that is, 12
hours (or this can be expressed as 15840 minutes).

Assuming that the targeted Service Availability (SA%) defined in the contract is
99%, then the maximum allowed non-compliance duration is 1% of 15840, that is:
158 minutes. If after 11 days and 2 hours of operation, the accumulated non-
compliance time is 100 minutes, then the current compliance violation level at that
time will be 100/158 = 63%.

6.4.3 Creating a New Service Level Agreement
1. Follow steps 1 to 3 in section 3.2.1 Creating a New Object from Scratch..

2. Whichever method used to start the process, choose Service Level Agreement
from the option box that is displayed.

3. The first SLA Creation window will be displayed.
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Figure 44 Create a Service Level Agreement, First Window
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4. Choose the Definition from the drop-down list. Definition is a mandatory field
and is therefore displayed in red until the choice is made.

5. Enter the optional Name.

6. Either type in an Identifier or click on the Wizard “< button to the right of the
Identifier field to automatically create an Identifier. Identifier is a mandatory field
and is therefore displayed in red until information is entered in this field.

7. Add a Description (optional).
8. Click on OK.

9. The second Create a Service Level Agreement dialog box will be opened in
Create mode.

10. This dialog box has two tabs, Details and Monitoring States. The dialog box is
opened with the Details tab displayed.
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Figure 45 Create a Service Level Agreement, Screen 2
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The Details tab screen is divided into four areas. The details of the SLA, the
Agreement Type area, the Service Group and Service Level selection area, and the
Service Hours Configuration area.

The Service Hours Configuration area is dedicated only to SLA compliance.

The Details Area
This area displays the details of the SLA.

The Agreement Type Area

For Customer dependent services, choose the Type of Service Level Agreement,
Customer or Operational.

If the Service is Customer independent, the only Type of agreement available is
Operational and this is the only displayed Type.

1. If the type Customer is chosen, the word Customer will be displayed in red to the
left of the field.

2. If the type Operational is chosen, the word Operational will be displayed in red to
the left of the field.

3. To the right of this field, the Choice button
becomes active when the cursor is placed over it. %

4. If the Customer type is chosen, the Open a Customer
dialog box is displayed and the Customer can be selected from the list displayed.
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When the choice is made, the Open a Customer dialog box is closed, and the
targeted Customer is displayed (grayed) in the Customer field. The information in
this field cannot be edited manually.

5. If the Operational type is chosen, the Open an Operation dialog box is displayed
and the Operation can be selected from the list displayed. When the choice is
made, the Open an Operation dialog box is closed, and the Operation is displayed
(grayed) in the Operation field. The information in this field cannot be edited
manually.

Associated Service Group and Service Level Area

1. An Associated Service Group has to be chosen. The text is displayed in red until
the choice is made.

2. To the right of the Service Group field the Choice button becomes active &
when the cursor is placed over it.

3. The Open a Service Group dialog box is displayed.
4. Choose a Service Group.

5. The Open a Service Group dialog box is closed, and the Service Group is
displayed (grayed) in the Service Group information field. The information in
this field cannot be edited manually.

6. A Service Level can also be associated, but this is not mandatory. The action has
to be performed in the same way as for the Associated Service Group.

7. If awrong choice of Agreement Type, Service Group or Service Level has been
made, repeat the process described above, choosing a different Object. The new
choice will be displayed (grayed) in the appropriate information field.

Service Hours Configuration Area

It is now mandatory to configure the service hours and configure the Schedule.

1. Enter the maximum number of minutes permitted for violation.

2. Enter the Reference period by choosing it from the drop-down list: Weekly,
Monthly, Quarterly.

3. Set the schedule.

Setting the Schedule

Setting the schedule determines when the SLA is active or not (in or out service
hours). When no schedule has been set, the SLA is considered as always active.

A schedule created on a given machine cannot be accessed by another machine, but
the schedule file can always be copied to another machine.

There are two ways of setting the Schedule:

e Open the Schedule Editor
by clicking on the button to the right of the Schedule field and enter all the needed
details.

Or

¢ Import a Schedule.
The schedule can be either used as it is or modified to your own needs. If a
schedule is imported and modified, the original is not modified, only the copy on
the local machine is. This process is described in the next section.

A schedule can also be created without associating it to a SLA.

69



Importing a Schedule

As well as creating schedules from scratch as described in the previous sections, a
previously created schedule can be imported. It can then either be used as is or
modified at will.

To import a Schedule:

1. Click on the Import button

- . . . £
in the Service hours configuration area. =!

2. The Import Dialog box is displayed, giving access directly to the schedule

directory.
Smport x|
Look ir: I[:I achedule LI I'::F

24x7-Sehedule xml
WORKINGHOURS xml

File name: || Import |
Files of type: IEx‘tended Markup Language (xml) :I Cancel |

Schedules are stored in the directory schedule. The path is:
UNSLACIient\schedule

3. Once this directory is accessed, select a schedule and click on Import in the
Import dialog box.

Removing a Schedule

The schedule currently attached to the SLA can be removed by clicking on the
Remove button. %

6.4.4 Setting the Schedule with the Schedule Editor

The Schedule Editor is used to create a new Schedule or to modify an existing one.

1. Click on the button =2 to the right of the Schedule field.
The Schedule Editor will open.
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Figure 46 The Schedule Editor
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Like other Editors, the window is divided into separate areas for separate activities:
Set Time Zone, Add Schedules, Current Schedule, and Add Exclusions.

Set Time Zone

1. Select a time zone from the drop-down list.

The time zones are organized under the five major continents as well as some
special areas. For example: the time zone for New York is America/New_York,
for Paris it is Europe/Paris. The time zone list can be navigated by typing the
first letter of the time zone.

Add Schedules

1. To activate the Add Schedules editor, click on the Add button to the right of the
Add Schedules area. Until then, none of the fields in the area can be edited. They

display information for the currently selected Schedule in the Current Schedule
area.

2. Once the Add button has been clicked, it changes to Cancel.
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A Schedules
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Cancel |
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3. Enter a name for the Schedule. Note that this Schedule is in fact a Schedule
element that is part of the whole edited Schedule.

4. Select one or more days for which the schedule applies.
5. Enter the time for the schedule to start and for it to finish.

6. The up and down arrows to the right of the fields can be used to set the Start Time
and End Time values. The time value can also be manually in entered.

7. When the OK button is clicked, the schedule is created and the name of the
schedule displayed in the Current Schedule area.

8. When a schedule has been added and displayed in the Current Schedule area, it
can be modified. The OK button becomes a Modify button. The schedule must be
selected in order to be modified.

Note

To validate the modification, click on the OK button that has replaced the Modify
button. Otherwise, the update will not be taken into account.

Current Schedule Area

Selecting a schedule in the Current Schedule area activates the Delete button to the
right of the display list, allowing the removal of this schedule.

Current Schedule:

Business Hours

Sunday Processing Delete |

When the schedule is displayed in the list, the selection remains on the first schedule
entered, therefore make sure that the right schedule is selected before deleting it.

Add Exclusions Area

This area allows specifying dates on which the schedule is not operational.
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Figure 47 Add Exclusions Area of Scheduler

Add Exclusions

Select days to exclude: Exclude these dates:

== = Spr 2004 = == ] |Aer 01 2004 d

S M T W T F s i | 30 2004

T2 3 == Remave |

4 5 B 7 & 9 10

11 12 13 14 15 16 17

15 19 20 21 22 23 24

25 26 27 28 29 30

|
Ok Cancel | Apply |

1. Inorder to add an exclude date, select it in the left-hand side calendar and click on
the Add button.
The calendar can be navigated by using the arrows at the top of it.
Several dates can be selected at once by maintaining the keyboard shift key
pressed while selecting them.

2. The date is displayed in the Exclude these dates panel.

3. Exclude dates can be removed by selecting them and clicking on the Remove
button.

Several dates can be selected at once by maintaining the keyboard shift key
pressed while selecting them.

Validating a Schedule

After all the Schedule details have been entered, the schedule must be validated.

Use the buttons at the bottom of the Scheduler window:

* Apply,
applies the modification without exiting from the Scheduler Editor.

e Cancel,
cancels all the modifications and exits from the Scheduler

e OK,
applies the modifications and exits the scheduler in one operation.

The position of these buttons is illustrated in Figure 46 and Figure 47.

Creating a schedule from scratch

In order for a schedule to be shared between SLAs, it must be created from the Create
menu. It is then saved into a file and can be imported in the various SLAs.

1. Click on the new button from the Toolbar.

2. The Create a Schedule dialog box is displayed. In the same way as for Creating a

Service, type a Name and an Identifier, or click on the Wizard button “ to
create the Identifier automatically. Enter a Description (optional) and click on
OK.
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Figure 48 Create a schedule dialog box
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3. Click on Edit to edit the schedule (see details in Section 6.4.4).

Figure 49 Schedule creation details
ER * schedule [My Schedule] - Create i =10 x|
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Description: |a, nes Schedule
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4. When the schedule has been edited, save the schedule with the Save button from
the Tool bar.

5. The schedule is then saved in UNSLACIient\schedule with the file name (in our
example) MySchedule.xml

6.4.5 Modifying or Editing a Service Level Agreement
Open the Service Level Agreement to modify as described in Section 3.4.

The Service Level Agreement Editor opens in Create mode. The modifications are
performed in the same way as when creating a new SLA. After having made the
changes, save the Agreement.
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6.4.6 How to Make a Service Level Agreement Operational

The Administrative State of an SLA controls the behaviour of the SLA and all its
elements (Service and Service Component Instances) in term of data collection,
parameters, statuses and compliance calculation.

When a SLA is Locked, SQM suspends all the services, service component instances
and Data feeders used in the SLA, provided these objects are not involved in the data
collection chain of another unlocked SLA or Service. For all these objects, the data
collection is stopped, and the parameter values are not published anymore. Also,
when a SLA is locked, the compliance and the statuses calculation is suspended for
all the objects of the SLA, even for the one that remains unlocked. When a SLA is
locked, the SLA is not reset, it is just suspended: the SLA and all its elements keep
their current statuses during the locked period.

When a SLA is Unlocked, SQM resumes all the services, service instances and Data
feeder used in the SLA. The collection, the parameters calculation, the statuses
calculation and the compliance calculation are available for all these objects. When
the SLA is resumed, the statuses of the all the elements of SLA are updated in
accordance to the current parameter values, in order to resynchronize it.

Note

Due to the fact that some components can be part of several services or SLA, it is
possible to have some parameter values updated during the locked period of a SLA,
but as the SLA is locked, the statuses are not updated. For this reason, you can have
some inconstancies when you chart parameters while the SLA is locked (status not in
accordance with parameter value).

It is also possible to continue data collection for a locked service component instance
in the following situation: the same DFI is used in locked and in unlocked service
component instances. In this case, SQM stores the collected values for each
component, but nothing will be published for locked components.

Lock/Unlock Impact on the compliance

The default behaviour is to consider Locked period as Off Duty period. This platform
wide behaviour can be changed: it is possible to reset all compliance parameters to 0
when resuming an SLA (see “Administration Guide” section 3.3.3 Service
Performance Data Manager for more details).

Lock/Unlock Impact in DataMart

In the DataMart, the locked periods are considered as Off Duty periods, and are not
taken in account for service heath and status history indicators.

Locking/Unlocking an SLA

To unlock an SLA, open the SLA and from the menu bar, click on the B
Resume triangle.

To lock the SLA, click on the Red ®  Suspend button.

These buttons are also available in the States Tab of the Service Level Agreement
Editor.
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Chapter 7

Troubleshooting

7.1

7.2

7.3

7.4

This chapter provides assistance about how to troubleshoot HP OpenView Service
Quality Manager SLA Level Administration User Interface.

Help

There is no Context-Sensitive Help provided with this version of the HP OpenView
Service Quality Manager SLA Administration application. Help can be obtained from
the On-line version of this manual.

On-line Manual

This manual is available on-line.

To display it:

1. From the Help menu, choose Content
or

2. Press F1.

The search facilities can be used to find Help on a specific subject.

Information and Error Display

The Service Quality Manager SLA Administration User Interface Console displays
messages that provide information about the actions performed.

Messages and tips are also displayed on the appropriate screen relating to the actions
to be performed, or just performed.

Connection and Timeout Problems

If there are problems when connecting to the SQM Repository server (the Connection
Icon is red when the application is started) or communicating with the SQM
Repository (timeout messages are received in the console and on the bottom bar of
the application window), the configuration of the SQM Repository should be
checked.

How to correct this is described in the HP OpenView Service Quality Manager
Administration Guide.

It explains how to change the connection parameters, and also how to configure the
timeout value.
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7.5 Object Identifiers (IDs)

All Objects must have an Identifier, and the Identifier must be unique.

If an Object with is created with a duplicate ID, it is not saved and a message is
displayed indicating that the ID must be changed.

To easily retrieve it in the different SQM GUIs, it is recommended to not use the
automatic generation.

We recommend that a list of Identifiers be kept in a separate file to which to refer
when creating a new one, to avoid wasting time in entering an Identifier which will
be impossible to save.

7.6 SQM Repository Errors

It is possible that some errors related to the SQM Repository can occur. If this occurs,
refer to the HP OpenView Service Quality Manager Administration Guide.
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Appendix A

Service Level Administration User
Interface Icons

This appendix is a glossary of the icons used in OpenView Service Quality Manager
SLA Administration User Interface.

There are some icons that are only seen when they pop up during an action, allowing
the user to perform the action which the icon represents. These icons are indicated
with an asterisk in parentheses (*).

Some icons are used in the OpenView Service Quality Manager SLA Administration

Ul, but are also Service Quality Manager Core icons. This is indicated in the
description of the icon.

The icons are presented here in the alphabetical order of their filename.

Icon Description
tey Add Existing Service Component (*)
T Add New Component (*)
. - *
:;E Assign Existing Component ( )
2 Assign Existing Service Component (*)

Auto Instantiate (*)

-:-II

B Close

Console

2y Copy

(%] Critical (Icon used in the Console) Also used as Stop.
g Customer (Service Quality Manager core icon)

& Cut
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&

=)
o

0 B &

o

L

=

L o W

Data Feeder (Service Quality Manager core icon)

Data Feeder, Bind (*)
Data Feeder, Unbind (*)
Delete

Duplicate Component (*)
Help

Help, Context Sensitive
Information (Icon used in the Console)
Instantiate (*)

Maximize

Minimize

New

New Line

Off Line: displayed on the bottom bar of the SLA Administration User
Interface Window when the SLA Administration application is not

available

On Line: displayed on the bottom bar of the SLA Administration User
Interface Window when the SLA Administration application is

available.

Open

Operation (Service Quality Manager core icon)
Paste
Confirmation (*)

Refresh

Resume
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Save

Save All

Search

Service Component Definition (Grey Cube) (Service Quality Manager

core icon)

Service Component Definition, Shared Component
(Service Quality Manager core icon)

Service Component Instance (Golden Cube) (Service Quality
Manager core icon)

Service (Service Quality Manager core icon)

Service Group (Service Quality Manager core icon)

Service Level Objective (Service Quality Manager core icon)

SLA Administration User Interface

Service Level Agreement (Service Quality Manager core icon)

Service Level (Service Quality Manager core icon)

Suspend

Warning (Icon used in the Console)

Wizard
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Keyboard Shortcuts

Appendix B

This appendix provides a list of the keyboard shortcuts used in HP Service Quality
Manager SLA Administration User Interface.

For example Ctrl/N indicates that the Control key and N have been pressed at the

same time.
Key Stroke(s) Action Performed
Ctrl/C Copy
Ctrl/D Delete
Ctrl/E Export
Ctrl/F Find
Ctrl/N Creates a New Object
Ctrl/O Opens an Object
Ctrl/S Save
Ctrl/vV Paste
Ctrl/wW Cut
Ctrl/F4 Close
F1 Help
F5 Refresh
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Appendix C

Strings Length Limitations

The length limitations for the editable fields of type string in the SLA Administration

Ul are indicated in the table below.

Field Length
Label 512
Description 1024
Additional Information 1024
Action On / Action Off 1024
Property Values 1024
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Glossary

This glossary defines terminology commonly used in HP OpenView Service Quality
Manager.

Auto instantiate (SLA Administration)

This action automatically creates an Instance of the Object selected. When the
instance is created, the initial values of its instance variables are assigned.

BI
See business intelligence.
Business intelligence (Bl)

A broad category of applications and technologies for gathering, storing, analyzing,
and providing access to data that helps users make better business decisions.

Collected binding

Describes how collected parameters are filled from measurement parameters: either
directly assigned or through a more complex expression.

Collected parameters

Known as KPI in the TMF, they represent the parameters collected from the Service
Adapters (measurement parameters) and mapped into SQM service component
parameters.

Computed binding

Describes how computed parameters are filled from collected parameters: either
directly assigned or through a more complex expression.

Computed parameters

Known as KQI in the TMF, they represent the parameters calculated from collected
parameters.

CNM
See customer network management
Customer

Companies or organizations that make use of the services offered by a service
provider, based on a contractual relationship.

Customer network management

Customer network management is enabled by means of tools that provide business
customers with access to management information originating from the service
provider.

Data collection interval

The interval of time over which performance parameters are retrieved from the
monitored service resources. This interval does not have to be the same as the
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measurement interval because service adapters or service resources may buffer
statistics.

Data feeder

OpenView Service Quality Manager’s source of data. A data feeder models service
resources by defining one or more service parameters.

Data feeder definition

The static definition of a data feeder that models service resources by defining one or
more service parameters.

Degraded service

The presence of anomalies or defects that cause degradation of the quality of service,
but do not result in the total failure of the service.

Instantiate (SLA Administration)
Instantiate differs from Auto Instantiate in that items are instantiated individually.
Measurement interval

The interval of time over which each service parameter is measured. For example, a
parameter may be the number of discarded packets, measured over a 15-minute
measurement interval.

Measurement parameters

They represent the parameters directly collected by the Service Adapters. These
parameters are defined in the Data Feeders.

Measurement Reference Point (MRP) naming scheme

This is the formal description of how the measurement point name is built, that is, by
concatenating the values of Data Feeder properties and fixed strings.

Mobile virtual network operator

A mobile operator that does not own its own spectrum and usually does not have its
own network infrastructure. Instead, MVNOs have business arrangements with
traditional mobile operators to buy minutes of use for sale to their own customers.

MRP

See Measurement Reference Point.
MVNO

See mobile virtual network operator.
Parameter

A value or set of values that are periodically updated and that help determine the
quality of service.

Parameter objective

A set of objectives for the parameters belonging to a service.

Property

Special static parameters that are given a value only when an instance of an
OpenView Service Quality Manager Object is created. For example, a Service
Component can have a property called “location”.

QoS

See quality of service.
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Quality of service (QoS)

The ITU-T has defined quality of service as "the collective effect of service
performances that determine the degree of satisfaction of a user of the service".

Service

A Service is a set of independent functions (Service Components) that consist of
hardware and software elements and an underlying communications medium. A
Service can include anything from a single leased-line service, to a complex
application, such as vision conferencing.

Service availability

A measurement made in the context of a service level agreement that is expressed as
a percentage. This percentage indicates the time during which the service is
operational at the respective service access points.

ServiceCenter Repository

The ServiceCenter Repository is the storage center for all Service Quality Manager
data. It receives data from the various Service Quality Manager interfaces and each
interface can request information from the Repository.

Service component

An independent function that is part of a service, such as a hardware or software
element, or the underlying communications medium.

Service component instance

The instance of a Service Component Definition that is active in the network, such as
an instance of the IPAccess Service Component definition called “pop”.

Service level (SL)

Defines Service Parameters and operational data enforced by the Service Level
Agreement (for example, Max Jitter < 10 ms).

Service level agreement (SLA)

There are two type of Service Level Agreement, the Customer Agreement: a contract
between a service provider and a customer, which specifies in measurable terms what
the service provider supplies to its customers, and the Operational Service Level
Agreement, which specifies in measurable terms the operational levels of the Service.
A service level agreement is composed of individual objectives.

Service level objective (SLO)

The set of objectives for the parameters belonging to a Service or Service
Component.

Service parameter
See parameter.
Service provider

A company or organization that provides services as a business. Service providers
may operate networks or may integrate the services of other providers.

Service instance (SI)

The instantiated service definition that is active in the network, such as an instance of
the video service definition called “Paris”.

Service instance group (SIG)

A group of service instances against which the service availability must be reported.
Each service instance belongs to one or more Service Instance Groups and each SIG
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contains at least one Service Instance. The relationship between the SIG and the
Service Instances is defined in their service level agreement.

Service quality parameters

They represent computed and collected parameters
Si

See Service Instance.

SIG

See Service Instance Group.

SL

See Service Level

SLA

See Service Level Agreement.

SLO

See service level objective.

Subscriber

The entity responsible for the payment of charges incurred by one or more users.
User

An entity designated by a customer to use the services of a telecommunication
network, such as a person using a UMTS mobile station as a portable telephone.
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Action - 17, 45, 54, 59, 60, 83
Auto Instantiating - 41, 42
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binding - 35, 44, 87

Binding - 43, 44

C

Compliance - 65

Creating - 19

Crossing - 55, 56, 57, 58

Customer - 12, 23, 24, 25, 36, 51, 63, 64, 65,
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Customer SLA - 9

D
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Deleting - 31

Diagnose - 40, 44, 45, 46

Duplicating - 30

E

Exporting - 29
I

Importing - 30
M

Measure Point - 36, 37
MRP - 36, 37, 88

o

Objective - 54, 55, 56, 57, 58, 59, 60, 61, 62,
81

Opening - 27

OpenView SQM - 9

Operation - 12, 23, 24, 25, 63, 65, 69, 80

Index

Operational SLA - 9
R

reference period - 66
Refreshing - 28
Register - 35, 36
Resume - 17, 45, 75, 80

S

Saving - 19

Schedule - 69, 70, 71, 72, 73, 74

Searching - 22

Service Group - 12, 21, 23, 24, 28, 46, 47, 48,
49, 50, 68, 69, 81

Service Hours - 65, 68, 69

Service Instance Group - 63

Service Level - 12, 15, 21, 23, 24, 51, 52, 53,
54, 55, 56, 57, 58, 59, 60, 61, 62, 63, 65, 66,
67, 68, 69, 74, 75, 79, 81, 89, 90

Service level agreement - See SLA

Service Level Agreement - 12, 63, 65, 66, 67,
68, 74, 75, 81, 89, 90

Service Level Objective - 53, 54

Service levels - 10

SLA-1,7,9,12,13, 15, 16, 17, 18, 19, 21, 23,
24, 28, 29, 35, 37, 62, 63, 65, 66, 68, 69, 70,
73,77, 79, 80, 81, 83, 87, 88, 89, 90
Definition of - 9

SLA lifecycle - 10

SLO - 56, 58, 65, 89, 90

States - 2, 32, 36, 37, 45, 47, 48, 67, 75

Suspend - 17, 45, 75, 81

T

Threshold - 55, 56, 57, 58, 59, 60
Thresholds - 55, 56, 57, 58

U
Unbinding - 43, 44
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